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Introduction

Welcome to Bento

The Database for the Rest of Us

Bento is a product from FileMaker, which is owned by Apple. Designed to bring
FileMaker’s database expertise to users of Mac OS X Leopard and later, it integrates
data from iPhoto, iCal, Mail, and Address Book with databases that you can create
from your own data as well as data imported from other sources.

Bento is lightweight in its structure but heavyweight in its capabilities. Because it
builds on so many years’ (actually decades’) worth of experience with users and
their needs both at FileMaker and at Apple, it is responsive to the frequently
expressed needs and frustrations of people who need more organization than a
word processing document or spreadsheet can provide but less complexity than a
full-featured multiuser database might provide. Organization is the key to making
information usable. A few items that are organized (ideas, recipes, addresses, bills,
or shoes) can be more useful than a thousand items that are scattered around hel-
ter-skelter with no organization scheme.

Released in beta in the fall of 2007 and in a final version in early winter 2008, Bento
caught on immediately. The response was positive both in reviews and in user
comments. Because the Bento team is so agile and also because its design is so
simple yet sophisticated, it was possible to produce a second version of the soft-
ware within a year.

The Bento team did not rest on their laurels. They continued to work hard, incorpo-
rating new features as well as important advances elsewhere in Mac OS X and in
the world of computing. Hard on the heels of Bento 2, the team released the Bento
iPhone app (available for download from the iTunes App store). Together with
Bento 2.5, which was a free upgrade, the Bento iPhone App lets you carry your
Bento data around with you.

As the people at Apple worked on Snow Leopard (Mac OS X version 10.6), the
Bento team worked to use new features to deepen the integration of Bento with
the rest of the Mac environment. And in perhaps the most significant advance in
Bento 3, it now is able to share data with up to five other computers on a local area
network. Together with the Bento iPhone app and Apple’s MobileMe service, this
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can mean that your data is always at your fingertips no matter where you are and
what device you are using. Then, in the Spring of 2010, the Bento team delivered
the Bento iPad app providing yet another perspective on your Bento data.

How This Book Is Organized

This book shows you how to use Bento and presents a number of projects that you
can use (with or without modification). The projects are designed to illustrate the
types of tasks that you can perform with Bento. You may choose to mix and match
features and functionality from various projects to create your own solutions.

The general structure of the book is as follows:

• In the first few chapters, you see how to use the built-in Bento libraries.

• Next, you see how to customize them.

• Then you see how to import data from another source, such as a spreadsheet.

• Finally, you see how to create and share libraries for data you enter from scratch.

Along the way, the chapters explore various combinations of these techniques.
Here is a summary of the chapters in the book:

• Chapter 1, “Bento: The Database for the Rest of Us,” provides an introductory
overview of Bento. It shows how you can organize your data, and it describes
the basic Bento terminology, which consists of just four words. You see how
to use the Bento window in both versions and how to set preferences.

• Chapter 2, “Using the Bento Window,” uses the built-in Notes library to show
you how to add and delete records, enter data, and find what you are looking
for (both using a simple and advanced find technique).

• Chapter 3, “Working with Bento Forms,” uses the built-in Classes library to
explore how you can customize libraries with themes, columns, labels, shad-
ing, text size, and text boxes.

• Chapter 4, “Building a Bento Library from Your Own Data,” provides a quick
overview of how to import data from another source such as a spreadsheet.
This topic is explored in more depth in Chapter 14, “Importing and Exporting
Bento Data and Libraries.”

• Chapter 5, “Working with Phone, URL, IM, and Address Fields and Lists in Con-
tacts,” explores the built-in Contacts library. You see how to use multiple
forms and how to work with lists of phone numbers, URLs, addresses, emails,
and IMs as well as how to add fields to a form.

• Chapter 6, “Working with Bento Fields and Calculations,” shows how you can
use calculation fields to make your data entry faster and more accurate. The
built-in Exercise Log serves as the example.
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• Chapter 7, “Expanding the Inventory Library with Related Records and Collec-
tions,” delves into the concept of related records. You see how to take the
built-in Inventory library and modify it so that it reflects additions or subtrac-
tions to or from inventory in a live, on-hand value.

• Chapter 8, “Synchronizing with the Bento iPhone and iPad Apps,” shows you
how to set up your iPhone and iPad and your Bento libraries for most effec-
tive synchronization.

• Chapter 9, “Sharing Data with Other Bento Users,” shows you how to config-
ure Bento for use over a local area network.

• Chapter 10, “Using Built-In Bento Libraries for Address Book and iPhoto,”
explores one of the most powerful parts of Bento: its integration with
Address Book in Mac OS X. Bento accesses the Address Book data, and it is
always live in the Bento display as well as in the Address Book display. You
also see how this ties into MobileMe so that the data in Bento and Address
Book is automatically synchronized with data elsewhere in your computing
environment. The same interfaces and technologies that allow Address Book
integration allow you to integrate Bento with your iPhoto library.

• Chapter 11, “Using Built-In Bento Libraries for iCal Tasks and Events,” contin-
ues to look at how Bento is automatically integrated with your data on Mac
OS X. This time, the iCal data is considered.

• Chapter 12, “Working with Bento’s Projects Library to Use Related Records
from iCal Tasks, iCal Events, and Address Book,” shows how the built-in Bento
Projects library uses the technologies described in Chapters 7, 10, and 11.
Related records from the built-in Mac OS X applications are associated with
specific projects. This allows integration so that, for example, iCal can display
tasks and events over a period of time and across many projects while you
can view each project separately in Bento. Furthermore, the integration of
iCal and Address Book with MobileMe means that your Bento tasks, events,
and contacts are automatically available on all your synchronized devices
from Macs to PCs to iPhones. This chapter also shows the feature that lets you
integrate messages from Mail with your Bento libraries.

• Chapter 13, “Designing a Projects Library to Share on Your LAN and Synchro-
nize with Your iPhone,” shows how you can customize the built-in Projects
library with structured notes. This capability allows you to enter and browse
comment and note data by date or other categories. Notes differ from tasks
and events not only in that they are stored totally in Bento, not in iCal, but
also because notes are a record of what has happened and been discussed in
a project—the past, as well as the future events and tasks. For many people,
this library may be all the project tracking they need.
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• Chapter 14, “Importing and Exporting Bento Data and Libraries,” explores
Bento data import and export. You also see how to create and use your own
Bento library templates.

• Chapter 15, “Using the Bento Template Exchange” shows you how to make
the most of the shared templates available online and how you can con-
tribute you own templates for others to use.

Using This Book

This book allows you to customize your own learning experience. The step-by-step
instructions in the book give you a solid foundation in using FileMaker Bento, while
rich and varied online content, including video tutorials and audio sidebars, pro-
vide the following:

• Demonstrations of step-by-step tasks covered in the book

• Additional tips or information on a topic

• Practical advice and suggestions

• Direction for more advanced tasks not covered in the book

Here’s a quick look at a few structural features designed to help you get the most
out of this book.

NOTE
Notes provide additional commentary or explanation that doesn’t fit neatly into
the surrounding text. Notes give detailed explanations of how something works,
alternative ways of performing a task, and other tidbits to get you on your way.

TIP
This element gives you shortcuts, workarounds, and ways to avoid pitfalls.

CAUTION
Every once in a while there is something that can have serious repercussions if
done incorrectly (or rarely, if done at all). Cautions give you a heads-up.



Cross-references: Many topics are connected to other topics in various ways.
Cross-references help you link related information together, no matter where that
information appears in the book. When another section is related to one you are
reading, a cross-reference directs you to a specific page in the book on which you can
find the related information.

LET ME TRY IT tasks are presented in a step-by-step sequence so you

can easily follow along.

SHOW ME video walks through tasks you’ve just got to see—including

bonus advanced techniques.

TELL ME MORE audio delivers practical insights straight from the

experts.

Special Features

More than just a book, your USING product integrates step-by-step video tutorials
and valuable audio sidebars delivered through the Free Web Edition that comes
with every USING book. For the price of the book, you get online access anywhere
with a web connection—no books to carry, content is updated as the technology
changes, and the benefit of video and audio learning.

About the USING Web Edition

The Web Edition of every USING book is powered by Safari Books Online, allowing
you to access the video tutorials and valuable audio sidebars. Plus, you can search
the contents of the book, highlight text and attach a note to that text, print your
notes and highlights in a custom summary, and cut and paste directly from Safari
Books Online.

To register this product and gain access to the Free Web Edition and the audio and
video files, go to quepublishing.com/using.

5About  the USING Web Edit ion



Downloadable Files and Web Support

For updates to the book, see the author’s website, www.northcountryconsulting.

Downloadable files for this book are available on the Web at:

• www.northcountryconsulting.com

• quepublishing.com/using

FileMaker is the developer of Bento. There are a number of resources on the
FileMaker site:

• www.filemaker.com/bento gets you to the basic Bento page.

• There is a discussion forum for Bento at http://forums.filemaker.com/fmbnto/.
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Working with Bento Forms

In this chapter you’ll see how to display Bento data in forms as well as how to work
with form tools and to customize forms with themes and fields.

Working with Forms

In Chapter 2, “Using the Bento Window,” you saw how to use the Libraries & Fields
pane to add fields. This chapter continues the discussion of fields and moves on to
forms, which display the fields in a library.

Forms can show fields from related libraries as you will see in Chapter 7,
“Expanding the Inventory Library with Related Data Fields and Collections,” p. 107.

Every Bento library can be shown in a table view, which Bento generates auto-
matically.

In Bento 3, a grid view is also generated automatically for each library. As you saw
in the previous chapter, you can modify the settings for the thumbnails shown in
the view.

In addition to the table and grid view, you can create and modify any number of
form views. Every library must have at least one form view. In most of the tem-
plates, it is called Form, but you can change the name.

This chapter begins by exploring the Classes library template; its table view is
shown in Figure 3.1. It contains a single record that is part of the template. In this
chapter, you see how you can customize a copy of that form so that you have both
the original and your modified form.

You select the fields to be shown in a table view by using the checkbox to the left
of the field name in the Fields pane, which is at the bottom of the Libraries & Fields
pane at the left of the Bento window. Because there is only one table view in a
library, whether a field is displayed in that table view is an attribute of the field, and
it can be set in the Fields pane.

In the navigation bar at the top of the Bento window, you can switch to the grid
view as shown in Figure 3.2.
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Figure 3.1 Display the Classes template in table view.

Figure 3.2 Use the Bento grid view.

The thumbnail in the grid view has been enlarged using the zoom control in the
upper right area of the grid view. As you saw in the previous chapter, it can display
a reduced-size image of a form or one or more of the images in a library.
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Figure 3.3 Use a form view.

In the navigation bar, the table and grid icons are always at the left. Moving to the
right, you find a vertical dividing line and then one or more forms. In the Classes
template, if you click the Form view you will see the form shown in Figure 3.3. This
is a form view, and the default view is called Form in this and many templates. To
be very precise, this is the Form form, but you do not have to worry about that
technicality if it gives you a headache.

The Fields pane makes a distinction between fields in the current library and those
in related data. You can see this clearly in the Assignments & Projects Due Dates
field, a field that shows related records from iCal. It shows up below the Fields sec-
tion in a Related Data section, as you see in Figure 3.3.

In form view, you are able to rename a form, create new forms, and delete a form.
(Except for the last one—there must always be at least one form in the library.) The
form in the Classes template is called Form. For this chapter, you are modifying that
form. The safest way to do that is to rename it “Original Form” and then to duplicate
it and work on the duplicate.

LET ME TRY IT

Form view button
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Figure 3.4 Rename a form.

Duplicate and Rename a Form

Duplicating and renaming a form is a good way to safeguard your existing form
before making changes.

1. Change the existing form’s name so that you can revert to it if necessary.
To change a form’s name, double-click its name in the navigation bar to
open the dialog shown in Figure 3.4. Note that as you change the Form
name, these changes are immediately reflected on the navigation bar.

2. You can also use Forms > Rename Form when you are viewing the form
you want to rename.

3. Type in the new name: Original Form, in this case.

4. Create the duplicate by choosing Forms > Duplicate Form. Bento dupli-
cates the form, with its default name “Copy” at the end.

5. Rename the duplicate form from “Original Form Copy” to “My Form” in the
same way you renamed Form to Original Form. Now you are ready to go.

SHOW ME Media 3.1—A video about how to duplicate and rename

a form

Access this video file through your registered Web Edition at
my.safaribooksonline.com/9780131388611/media.

Using Form Tools

You can customize a form in three ways. Direct manipulation lets you resize and
move fields by showing their handles and then dragging the handles or the field to
its new size and location. A selected form or fields within it can also be customized
using menu commands. A button in the lower right corner of the Bento window
lets you show the Form tools, as you can see in Figure 3.5. You have already seen
how to use the Form tool at the left: It opens the dialog shown previously in
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Figure 3.5 Show the Form tools.

TELL ME MORE Media 3.2—A discussion about how, when, and

why to use form tools

Access this audio recording through your registered Web Edition at
my.safaribooksonline.com/9780131388611/media.

Customizing a Form with Themes

Like Keynote with its styles, Bento lets you apply visual themes to your forms. These
coordinated appearances combine a selection of colors and fonts in various styles.
With a form selected, you can change its theme by choosing Forms > Theme
Chooser. Unlike Keynote, Bento does not allow you to change the details of the
themes. However, because of the large number of provided themes, you are likely
to find themes you like.

A Bento theme is totally separate from your data. That means you can switch
themes at any time without affecting your data. The various templates use a variety
of themes, but you can change them at will.

Figure 3.4 to rename the current form. You see how to use the other tools through-
out this book. Most of them provide alternate access to menu commands (for
which you frequently have other access through keyboard shortcuts). Instead of
the button, you can use View > Show Form Tools to show the Form tools.
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Figure 3.6 Use the Themes form tool and Theme browser to select a theme.

3. When you click it, you see the available themes in the small window that
appears above the tools. (The downward pointing arrow in the Mac inter-
face always means that another window will be opened rather than hav-
ing a simple action performed.) You can select the theme you want to use
and see it applied to your form as you watch.

If you want to be sophisticated about your Bento themes, you can select several of
them to use for specific purposes, such as displaying confidential data from work,
displaying social data, and the like.

Themes are applied to the active form; when you go to a table or grid view, that
theme is applied to the table or grid view. If you then go to another form in the
library that uses a different theme, that other theme is applied to the table or grid
view when you navigate from the second form to the table view.

LET ME TRY IT

Choose a Theme

There are more than two dozen themes available. You can choose them using the
Themes form tool or the Theme Chooser.

1. Go to the form you want to theme.

2. To use the Theme form tool, show the Form tools and select the Themes
tool as shown in Figure 3.6.
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Figure 3.7 Use Theme Chooser to vary the look of your forms.

4. Click the close box in the upper left corner to dismiss the themes.

5. You can also open the Theme Chooser dialog for the current form by using
Forms > Theme Chooser as shown in Figure 3.7.

6. Select the theme you want to try. Click Try It to see it take effect in the
window behind the Theme Chooser. You can resize the dialog somewhat
so that you can see the effects while it is still open.

7. Click Choose to apply the theme and close the Theme Chooser.

8. If you do not want to change the theme, click Cancel to close the Theme
Chooser with no changes.

TIP
If you are not very familiar with Bento’s themes, make a note of the theme you
are changing from so that you can change back to it easily without searching
through all the themes to find out which one it was.

SHOW ME Media 3.3—A video about applying a new theme to a

form

Access this video file through your registered Web Edition at
my.safaribooksonline.com/9780131388611/media.
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Customizing a Form’s Fields

To customize a library’s table view, you use the Fields pane (to control which fields
are shown) and directly manipulate the table. You can reorder columns, show or
hide the summary row, and change column width. You can customize a form by
clicking its label to move or change it. If you click in the field itself, you are able to
enter data. Clicking its label or border shows handles that you can use to resize the
field, as shown in Figure 3.8. (Note the handles on the Name field; note, too that
the pointer has changed to a hand from the normal pointer when you are editing
fields rather than their data.) When the handles are visible, you can drag on the
field’s border to move it. If you click in the center of the field, the handles disap-
pear, and you are able to enter data.

Figure 3.8 Move and reshape fields in Bento.

You can add fields to a form by simply dragging them from the Fields pane. Bento
puts the labels in the appropriate location and coordinates their appearance with
the appearance of the relevant field using the currently selected theme. When you
drag a field from the Fields pane into a form that you are editing, an outline of the
label and data field appears as soon as you move your mouse into the Records
area, as shown in Figure 3.9. Note that a field can appear only once on a given
form. It can appear on as many forms as you have, but only once on each.

Some fields require more than one data entry element; if so, they are shown in the
outline and are placed in the form as soon as you release the mouse button. A
heavy line shows you where in the form the new field and label are placed. In
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Figure 3.9 Bento automatically provides the label and data entry fields.

Figure 3.9, a URL list is being placed on the form; it is one of the field types that
require several elements for display and entry.

For more details about these composite data fields, see Chapter 5, “Working with
Phone, URL, IM, and Address Fields and Lists in Contacts,” p. 77.

After a field and its label have been placed on a form, you can change its width or
height by selecting it and dragging the right or bottom border. You can also
rearrange fields; just drag them up or down or from column to column. Bento takes
care of everything for you—fields move aside as needed. And, of course, the tab
order remains logical (top to bottom and left to right in column one, and then on
to column two with the same ordering). To rearrange fields after you have already
added them, you click the label or border of a field to begin editing it.

Bento provides you with several formatting objects that you can add to a form
using the Objects form tool pop-up menu. Figure 3.10 shows how you can add a
horizontal separator—it is being placed just below the Description field.

A horizontal separator is visible in the finished form. Two other formatting objects
are not visible except when you are editing the form. In Figure 3.11, you can see a
column separator between the two columns. Although it is not visible after you
have finished editing the form, it helps Bento keep the columns in line.

You can also add a spacer. As you can see, Bento positions fields in each column of
a form starting at the left of each row. If you want to indent a field, add a spacer at
the beginning of the row. It will not be visible, but it will have the effect of pushing
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Figure 3.11 Only the horizontal rule is directly visible in the finished form.

Figure 3.10 Use form objects to help format a form.

the fields in that row to the right. You can resize the spacer so that the fields look
exactly the way you want them to. You can see a spacer placed in Figure 3.11. It
pushes the field and label to the right (both field and label automatically move
together).

Horizontal separator
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Add these objects by using the Objects button in the Form tools or by using the
appropriate commands in the Insert menu.

Table 3.1 describes each of the form tools from left to right and provides keyboard
equivalents.

NOTE
Figures illustrating the use of the various tools are referenced in Table 3.1. Some
of them are covered in later chapters.

Table 3.1 Form Tools

Tool Equivalent Purpose

Form Double-click form name in the Change a form’s name (Figure 3.4)

navigation bar or Forms > Rename Form.

Field Opens the Create a Field dialog Open the Create a Field dialog (Figure 6.2).

Text Box Insert > Text Box You can type anything you want in the text box, and

you can move it around the form just like a field.

Unlike a field, this is not data from your library; it is

simply text that appears on the form.

Image Box Insert > Image Box Creates an image box. See Chapter 6.

Objects Insert > Horizontal Separator A spacer is a blank area that also can be moved 

Insert > Column Divider around. You use it to add space between fields. 

Insert > Spacer There is also a horizontal separator (a line) that can

be used to separate groups of fields.

Themes Forms > Choose Theme Select a theme.

Labels Forms > Labels Choose Above or Beside as well as Small, Medium or

Large.

Shading Forms > Shading Choose None, Light, or Dark for selected field(s).

Text Size Forms > Text Size Choose Smallest to Largest for selected field(s).

Align Edges Forms > Align Right Edges Align right edges of selected Align Right Edges 

objects. Other edges remain where they were. 

Note that this command is not available if the right

edges are already aligned.
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The field consists of the label and the data entry section(s); a background may be
shaded for the entire rectangle that contains these elements. In the Format menu
or the Form tools, you can choose the degree of shading you want. They can be
effective in highlighting essential (or nonessential) information as long as you use
shading consistently.

You can also change the size of the text in the data fields, as well as the size of the
label. Finally, you can select two or more fields and align their right edges. You do
this by expanding the narrower fields’ widths so that all are consistent.

LET ME TRY IT

Copy Forms within a Library

If you have a library with one or more collections within it, you can copy your forms
to and from the library and each of its collections so that your design work can be
reused. It also makes it easier to use the library and its collections if the forms are
the same in each environment.

1. Start from a library that contains one or more collections or from a collec-
tion (it is always part of a library).

2. Navigate to the form you want to copy.

3. Control-click the form name in the navigation bar to bring up the short-
cuts menu as shown in Figure 3.12.

4. Select where you want to copy the form to. Your choices will be the library
itself and all of its collections except for the environment you are currently in.

TIP
Be wary of going overboard with these design elements. If you find yourself
needing to organize your forms with spacers and separators, maybe you would
be better off splitting your form into two separate forms. As described in
Chapter 7, “Expanding the Inventory Library with Related Records and Collec-
tions,” you can use collections and related records to bring whole sets of data
onto a form in a simple way. Bento works best for most people when you can
see all the data elements in a form without scrolling the window.



SHOW ME Media 3.4—A video about copying a form within

a library

Access this video file through your registered Web Edition at
my.safaribooksonline.com/9780131388611/media.
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Figure 3.12 Copy a form with the shortcuts menu.
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table views
fields, editing, 44
pasting data into, 43
records area, 30
sorting, 42



C

Calculation dialog, 96-97
calculation fields, adding

to Exercise Log, 87-89
calculations, 96

Calculation dialog, 
96-97

Calories Burned field,
100-101

creating, 98-100
Duration field, 98

calendars, 174
multiple calendars, 180

Calories Burned field, 
100-101

checkbox fields, 20
creating and format-

ting, 102
choice fields, 20

creating and 
formatting, 101

choosing themes, 54-55
cleaning up imported

data, 74-75
collections, 22-24, 122-

123. See also Smart 
Collections

adding records to, 
123-124

creating
empty, 123
from selected 

records, 124
Smart collections, 

125-127
comma-separated value

(CSV), 65
contact data, Contacts

library, 85

Contacts library, 77-80
adding fields and lists,

84-85
contact data, 85
fields, 81

entering contact
data, 81-82

menus, 82-83
copying forms within

libraries, 60
counters, automatic 

counters, 20
CSV (comma-separated

value), 65
currency fields, 19

creating and format-
ting, 103

customizing
fields, Projects library,

192-193
forms

fields, 56-60
with themes, 53-55

D

data, 10-11
basic data import, per-

forming, 67-69
calendars, managing,

180-181
cleaning up imported

data, 74-75
contact data, Contacts

library, 85
entering in Contacts

library, 81-82
exporting, 218-219
finding in records area,

38-39
Advanced Find, 39-41

importing
into existing libraries,

213-214
into new Bento

libraries, 69-73
legacy data, 

reviewing, 64
mobility, 12
organizing, 63-64
pasting into table

views, 43
securing, 149-150

database passwords,
151-152

encrypted fields, 
150-151

locked fields, 152-154
securing on 

iPhones or iPad, 144
synchronizing with

MobileMe, 167-168
tables, creating for

imported data, 
214-218

data detectors (Mac OS X)
Mail, iCal, 178-179
updating Address

Book, 168
data elements, 10
data formats, 64-67
data structure, iCal, 

175-176
data structuring, 16
database passwords, 

151-152
databases, connecting to

shared databases, 148
date, fields, 19
date and time field 

controls, 92-94
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deleting
fields, 91-92
records, 42

from Ins & Outs
library, 119

Details form, related
records from iCal and
Address Book, 187

Details layout, Projects
library, 184

duplicating
fields, 91-92
forms, 52

Duration field, 
calculations, 98

duration fields, 19

E

editing
events, iCal, 174
fields, 104-105

with table views, 44
empty collections, 

creating, 23
encrypted fields, 20, 

150-151
Energy Saver control

panel, 196
entering contact data in

Contacts library, 81-82
events

iCal, 174
synchronizing, 182

naming, 190-191
sharing with MobileMe,

193-194
Exercise Log

calculation fields,
adding, 87-89

calculations, 96
Calculation dialog,

96-97
creating, 98-100
Duration field, 98

Calories Burned field,
100-101

date and time field
controls, 92-94

number fields, 95-96
start date field, creat-

ing, 91-92
stop date field, 

creating, 89-91
existing structures,

reusing, 207
Export command, 65
exporting

Bento libraries as 
templates, 220

data, 218-219

F

fields, 17-21
Address Book library,

158-160
and lists, Contacts

library, 84-85
automatic counter

fields, creating and
formatting, 103-104

calculation fields, 87-89
Calories Burned field,

100-101
checkbox fields, 20

creating and 
formatting, 102

choice fields, 20
creating and 

formatting, 101

Contacts library, 81
entering contact

data, 81-82
currency fields, 

creating and 
formatting, 103

date and time field
controls, 92-94

deleting, 91-92
duplicating, 91-92
duration fields, 19
editing, 104-105

with table views, 44
encrypted fields, 20,

150-151
file list fields, 20
forms, customizing, 

56-60
locked fields, 152-154
media fields, 19
message list fields, 20
Notes field, 

creating, 202
number fields, creating

and formatting, 95-96
Projects library, cus-

tomizing, 192-193
Quantity field, 108
rating fields, 20

creating and 
formatting, 104

related data fields, 20
adding, 114
adding data to, 

116-117
formatting, 115
summarizing, 118

renaming, 91-92
simple lists, 20
start date field, 

creating, 91-92
stop date field, 

creating, 89-91
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Fields dialog, 19
Fields pane

Bento window, 25
forms, 51

file list fields, 20
FileMaker Pro, 197
FileMaker Server, 197
finding data, records area,

38-39
Advanced Find, 39-41

form view, 51
formats, data, 64-67
formatting

automatic counter
fields, 103-104

calculations, 96
Calculation dialog,

96-97
Duration field, 98

checkbox fields, 102
choice fields, 101
currency fields, 103
number fields, 95-96
rating fields, 104
related data fields, 115

forms, 49
adding images with

image boxes, 185-186
Address Book library,

158-160
copying within

libraries, 60
customizing with

themes, 53-54
choosing themes, 

54-55
duplicating, 52
fields, customizing,

56-60
Fields pane, 51
form view, 51

grid view, switching 
to, 49

relationships, 
improving, 119-121

renaming, 52
revising with Projects

library, 192-193

G

grid views, 30-31
switching to, 49

H

Home button, Bento
iPhone app, 133-134

horizontal separators, 57

I-J-K

iCal, 155, 171
data detectors (Mail),

178-179
data structure, 175-176
events, 174

synchronizing, 182
managing calendar

data, 180-181
Projects library, 199
related records, 

187-188
relationships, 211
Search Results pane,

172
searching, 172-174
To Dos, 171, 174-176

iCal Events, 155
iCal libraries, 176-178
iCal Tasks, 155

identification 
numbers, 227

image boxes, 185
adding images to

forms, 185-186
Projects library, 185

images, adding to forms
with image boxes, 
185-186

Import Data button, 28
imported data, cleaning

up, 74-75
importing

Bento libraries as tem-
plates, 220

data
into existing libraries,

213-214
into new Bento

libraries, 69-73
improving relationships

and forms, 119-121
Ins & Outs library

creating, 109-111
records, deleting, 119
related records, 

reviewing, 118-119
inventory, tracking 

with relationships, 
112-114

Inventory library, 107-109
Ins & Outs library, cre-

ating, 109-111
related records, review-

ing, 118-119
tracking inventory with

relationships, 112-114
iPad, 131-133
iPhones

Bento iPhone app, 131
creating new

libraries, 136-137
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Home button, 
133-134

searching 
libraries, 134

securing Bento 
data, 144

synchronizing, 129
with Address Book,

164-166
with iTunes, 165

synchronizing 
libraries with your
computer, 138

doing your first sync,
140-144

same wi-fi network,
138-139

iPhoto Bento library, 155
iPhoto library, 169-170
iTunes, setting up 

iPhone synchronization
with, 165

iWork applications, Pages
and Numbers, 65

L

LAN, shared libraries, 197
legacy data, reviewing, 64
libraries, 12, 22

Address Book library,
155-158

extending with new
fields and forms,
158-160

Bento iPhone app, 137
Contacts library, 77-80

adding fields and
lists, 84-85

contact data, 85
fields, 81-82
menus, 82-83

copying forms 
within, 60

creating, 9, 28
with Bento iPhone

app, 136-137
creating for Notes, 

200-202
creating new, 25
exporting as 

templates, 220
iCal libraries, 176-178
importing as tem-

plates, 220
importing data, 

213-214
importing data into

new, 69-73
Ins & Outs library, cre-

ating, 109-111
Inventory library, 

107-109
Ins & Outs library, cre-

ating, 109-111
related records,

reviewing, 118-119
tracking inventory

with relationships,
112-114

iPhoto library, 169-170
Notes library, 28
Project Notes 

library, 202
Projects library, 183-

185, 198-199
Details layout, 184
enhanching relation-

ships, 207-211
fields and forms, cus-

tomizing, 192-193
image boxes, 185
Notes, 199-200
related data fields,

adding, 
203-204, 207

templates, 184

searching with Bento
iPhone or iPad app,
134

shared libraries, 147
connecting to, 148

synchronizing 
between iPhone or
iPad and your
computer, 138-144

Libraries & Fields pane, 44
library folders, 45-46
library icons, 46-47

Libraries pane, Bento 
window, 25

library folders, Libraries &
Fields pane, 45-46

library icons, Libraries &
Fields pane, 46-47

lists, and fields (Contacts
library), 84-85

Lock/Unlock Encrypted
Fields command, 151

locked fields, 152-154
Login Options, 13

M

Mac, templates, 137
Mac OS X, TextEdit, 66
Mac OS X data detectors,

updating Address 
Book, 168

MacBook, synchronizing,
195-196

Mail
data detectors, iCal,

178-179
related records, 191

managing calendar data,
180-181
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media fields, 19, 107
menus, Contacts library,

82-83
message list fields, 20
MobileMe, 12, 130

Address Book contacts,
creating and sharing,
193-194

calendar events, creat-
ing and sharing, 
193-194

iCal, synchronizing, 182
synchronizing

with Address Book,
161-163

data, 167-168
with iPhone, 166

N

naming
events, 190-191
tasks, 190-191
templates, 226

navigation bar, records
area, 29

New Library dialog, 25, 79
Newton, 179
Notes, 199-200

creating Notes 
field, 202

creating new Bento
library for, 200-202

Notes field, creating, 202
Notes library, 28
number fields, creating

and formatting
(Exercise Log), 95-96

numbers, fields, 19

O

organizing data, 63-64

P

Pages and Numbers 
files, 65

passwords
database passwords,

151-152
sharing passwords, 154

pasting data into table
views, 43

PDAs, synchronizing with
Address Book, 167

PDF (Portable Document
Format), 65-66

PDF button, 37
performing syncs, 144
Portable Document For-

mat (PDF), 65-66
preferences, setting, 47-48
printing records, 36-37
procedural 

programming, 12
programming, 12
project management, 199
Project Notes library, 202
Projects library, 183-185,

198-199
Details layout, 184
fields and forms, cus-

tomizing, 192-193
image boxes, 185
Notes, 199-200
related data fields,

adding, 203-204, 207

relationships, enhanc-
ing, 207-211

templates, 184

Q

Quantity field, 108

R

rating fields, 20
creating and format-

ting, 104
records, 21-22

adding to collections,
123-124

collections, 
creating, 124

deleting, 42
from Ins & Outs

library, 119
printing, 36-37
related records

adding, 187-191
Mail, 191

records area, 29-30
Advanced Find, 39-41

records area
Bento window, 25
creating new, 33-34
deleting records, 42
finding data, 38-39
grid views, 30-31
printing records, 36-37
split views, 31-33
table views, 30
text data, 35

spell checking, 35-36
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related data fields, 20
adding, 114

data to, 116-117
to Projects library,

203-204, 207
adding with data, 117
formatting, 115
summarizing, 118

related records
adding, 187-191
Mail, 191
reviewing, 118-119

relationships
creating by dragging

libraries onto forms,
112-114

improving, 119-121
Projects library, 

207-211
related data fields, 117
tracking inventory, 

112-114
renaming

fields, 91-92
forms, 52

reusing existing struc-
tures, 207

reviewing
legacy data, 64
related records, 

118-119
revising forms, Projects

library, 192-193
Rich Text Format (RTF), 65
roles of Bento, 11
RTF (Rich Text Format), 65

S

“same wi-fi network,”
138-139

Search Results pane, 
iCal, 172

searching
iCal, 172-174
libraries, Bento iPhone

or iPad app, 134
securing

Bento data on your
iPhone or iPad, 144

data, 149-150
database passwords,

151-152
encrypted fields, 

150-151
locked fields, 152-154

security, 149-150
database passwords,

151-152
encrypted fields, 

150-151
locked fields, 152-154

Set Bento preferences, 
47-48

shared databases, con-
necting to, 148

shared libraries, 147
connecting to, 148
LAN, 197
synchronizing, 197-198

sharing, 145
setting up, 145-147
templates, 227-229
versus synchronization,

129-130

sharing passwords, 154
simple lists, 20
Smart Collections, 22-24,

125-127, 158
Smart Groups, 157-158
sorting table views, 42
spacers, 57
spell checking, text data,

35-36
split views, 31-33
spreadsheets, 75
start date field, creating in

Exercise Log, 91-92
stop date field, creating in

Exercise Log, 89-91
summarizing related data

fields, 118
switching

between Bento and
Address Book, 155

to grid view, 49
synchronizing, 195

Address Book
with iPhone, 164-166
with MobileMe, 

161-163
with PDAs, 167

Address Book and
Address Book library,
160-161

Bento libraries, 195-198
data with MobileMe,

167-168
iCal events, 182
libraries between

iPhone or iPad and
your computer,
138-144

versus sharing, 129-130
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syncs, performing, 144
System Preferences, 

managing accounts, 13

T

table views, 42
fields, editing, 44
pasting data into, 43
records area, 30
sorting, 42

tables, creating for
imported data, 214-218

tasks, 176
naming, 190-191

templates, 26
Bento library, 78
Bento Template

Exchange, 223
learning from, 

226-227
sharing, 227-229

exporting Bento
libraries as, 220

importing Bento
libraries as, 220

Mac, 137
naming, 226
Projects library, 184

text, fields, 19
text data, 35

spell checking, 35-36
TextEdit, 66
themes, forms, 53-54

choosing themes, 
54-55

time, fields, 19
To Dos, iCal, 171, 174-176
tracking inventory with

relationships, 112-114

U

updating Address Book
with Mac OS X data
detectors, 168

V

views
form view, 51
grid views, 30
split views, 31-33
table views, 30

fields, editing, 44
pasting data into, 43
records area, 30
sorting, 42

W-X-Y-Z

windows, Bento windows,
25, 28

libraries, creating, 28
records area, 29-30

Bento window, 25
creating new, 33-34
deleting records, 42
finding data, 38-39
grid views, 30-31
printing records, 

36-37
split views, 31-33
table views, 30
text data, 35

table views
fields, editing, 44
pasting data into, 43
records area, 30
sorting, 42
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